Table of Contents

1 Disclaimers and License ........................................................................................................ 4
   1.1 Disclaimer of Warranty ................................................................................................. 4
   1.2 License ....................................................................................................................... 4
   1.3 Disclaimer of "Check for updates' ................................................................................ 4
2 What is DirSync Pro? ........................................................................................................... 5
3 User Interface ...................................................................................................................... 5
   3.1 Menu and Toolbar ........................................................................................................ 6
   3.2 Main Window .............................................................................................................. 8
      3.2.1 Job Tree ............................................................................................................... 8
      3.2.2 Synchronization queue ........................................................................................ 10
         3.2.2.1 Synchronization queue: Summary tab ............................................................. 10
         3.2.2.2 Synchronization queue: View tab ...................................................................... 11
         3.2.2.3 Synchronization queue: Filter tab .................................................................... 12
      3.2.2.4 Right mouse click context menu ........................................................................ 13
      3.2.3 Schedule queue ..................................................................................................... 15
      3.2.4 Messages ............................................................................................................... 16
   3.3 Job options .................................................................................................................... 17
      3.3.1 Basic options ........................................................................................................ 17
      3.3.2 Compare options ................................................................................................... 20
      3.3.3 Copy options ......................................................................................................... 21
      3.3.4 Conflict Resolution options ................................................................................ 22
         3.3.4.1 Mono-directional sync conflict resolution ......................................................... 22
         3.3.4.2 Bi-directional sync conflict resolution ............................................................... 23
      3.3.5 Filters options ...................................................................................................... 24
         3.3.5.1 Adding/Editing a filter: Basics tab .................................................................... 25
         3.3.5.2 Adding/Editing a filter: By Pattern tab ............................................................... 27
         3.3.5.3 Adding/Editing a filter: By File Size tab ............................................................. 28
         3.3.5.4 Adding/Editing a filter: By File Date tab ............................................................ 29
         3.3.5.5 Adding/Editing a filter: By Path tab .................................................................. 30
         3.3.5.6 Adding/Editing a filter: By Attribute tab ............................................................ 31
         3.3.5.7 Adding/Editing a filter: By Ownership tab ........................................................ 32
         3.3.5.8 Adding/Editing a filter: By Permission tab ......................................................... 33
      3.3.6 Deletion options ..................................................................................................... 34
      3.3.7 Backup options ..................................................................................................... 35
      3.3.8 Logging options .................................................................................................... 36
      3.3.9 Schedule options .................................................................................................. 37
         3.3.9.1 Adding/Editing a schedule: Basics tab ............................................................... 38
         3.3.9.2 Adding/Editing a schedule: Schedule Once ....................................................... 39
         3.3.9.3 Adding/Editing a schedule: Schedule Minutely .................................................. 40
         3.3.9.4 Adding/Editing a schedule: Schedule Hourly ..................................................... 41
         3.3.9.5 Adding/Editing a schedule: Schedule Daily ....................................................... 42
         3.3.9.6 Adding/Editing a schedule: Schedule Weekly .................................................... 43
         3.3.9.7 Adding/Editing a schedule: Schedule Monthly .................................................. 44
      3.3.10 Advanced options ............................................................................................... 45
      3.3.11 Job Actions .......................................................................................................... 47
   3.4 Generate command line tool ........................................................................................ 48
   3.5 Application Options window ....................................................................................... 49
      3.5.1 General options ..................................................................................................... 49
         3.5.1.1 Update window ................................................................................................. 50
      3.5.2 View options ......................................................................................................... 51
      3.5.3 Synchronization options ....................................................................................... 52
      3.5.4 Log options ......................................................................................................... 53
   3.6 Command Line ............................................................................................................. 53
   3.7 Advanced features ....................................................................................................... 54
      3.7.1 Default directory for program settings ................................................................. 54
      3.7.2 Default directory for saving logs ............................................................................ 54
      3.7.3 Default directory for saving configurations ........................................................... 55
3.7.4 Log behavior........................................................................................................55
3.7.5 Schedule a synchronization................................................................................55
3.7.6 Auto start in MS Windows...................................................................................55
3.7.7 Allocating more memory for DirSync Pro..........................................................56
4 Frequently Asked Questions (FAQ)........................................................................56
1 Disclaimers and License

By using DirSync Pro you confirm that you have read and accepted the disclaimers and the license terms.

1.1 Disclaimer of Warranty

DirSyncPro IS DISTRIBUTED IN THE HOPE THAT IT WILL BE USEFUL, BUT WITHOUT ANY WARRANTY; THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. THE COPYRIGHT HOLDERS PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

1.2 License

DirSyncPro is free software: you can redistribute it and/or modify it under the terms of the GNU General Public License as published by the Free Software Foundation, either version 3 of the License, or (at your option) any later version. The file GPL.txt which is provided along with DirSync Pro, contains a copy of the GNU General Public License. If you could not find this file, see http://www.gnu.org/licenses/.

The icons used in DirSync Pro are from the Kommon Desktop Environment KDE (www.kde.org) released under the GPL.

1.3 Disclaimer of 'Check for updates'

By default (every new version of) DirSync Pro checks for program updates as soon as the program is started (and the license is accepted). Except in the unstable versions, you may disable checking for updates in the Options menu (Tools > Options). When checking for updates, DirSync Pro will send ONLY the current program alphanumeric version indication (for example ‘1.51’ or ‘1.51b1’) to the update server to verify if a newer version is released.
2 What is DirSync Pro?

DirSync Pro is a small, but powerful utility for file and folder synchronization. DirSync Pro can be used to synchronize the content of one or many folders recursively. Use DirSync Pro to easily synchronize files from your desktop PC to your USB-stick (/External HD/PDA/Notebook, ...). Use this USB-stick (/External HD/PDA/Notebook, ...) to synchronize files to another desktop PC.

Using DirSync Pro you can make incremental backups. In this way you'll spare lots of time because you don't have to copy all the files each time you want to update your backup; only new/modified/larger files would be copied. DirSync Pro provides some preconfigured modes (e.g. Mirror, Backup, Contribute, ...) for common synchronization and backup tasks and some custom modes in which the user could set up the synchronization behavior to meet specific wishes. Prior to synchronization, DirSync Pro performs an analysis on files and folders and detect any kind of changes to any file/directory in the source. If a file is for example modified, removed, deleted, renamed in the source DirSync Pro synchronizes the destination accordingly. DirSync Pro detects also changes to file meta data (e.g. DOS attributes, POSIX file ownerships/group/permissions) and could preserve them to the destination file/directories.

DirSync Pro has a user-friendly User Interface which helps you configure many options to your needs. You can use DirSync Pro also through the command line which makes it very flexible for running in batches.

DirSync Pro lets you define advanced filters based of filename patterns (textual and regular expression based), file sizes, modification dates, file paths and file meta data to include or exclude file/directories as desired.

DirSync Pro has a powerful schedule engine which lets you schedule synchronization tasks on many different ways, minutely, hourly, daily, weekly and monthly. Advanced users may use tons of options available in DirSync Pro to suit the synchronization behavior in details. DirSync Pro has many logging facilities which let you create detailed logs even per job.

DirSync Pro provides a real-time synchronization option which watches the source directory continuously and synchronizes the changes into the destination directory if a file/directory is changed.

Unlike many other synchronization software, DirSync Pro is Open Source; it is 100% free of charge, 100% free of commercial text, 100% free of advertisements and 100% free of spyware. You can use it as long as you like, without any limitations in time or functionality. You can freely distribute it according to GPL3.

DirSync Pro is programmed completely in platform independent Java™ so it can be run under nearly every modern operating system including Windows™, Linux™ and Macintosh™.

3 User Interface

Synchronize can be configured via a GUI. You can use the GUI to execute a synchronization, or you can use the GUI to create a jobset file and run the synchronization in console mode.
### 3.1 Menu and Toolbar

| 1. | Create a **New** jobset. |
| 2. | Open an existing jobset. |
| 3. | Open Recently loaded jobsets. |
| 4. | Load and **Append** a saved jobset to the current one. |
| 5. | **Save** the current jobset. |
| 6. | **Save** the current jobset **As** a new file. |
| 7. | **Save** the enabled jobs **As** a new file. |
| 8. | Quit the program. |
| 9. | Start to **Analyze** the jobs. No synchronization will be carried out. The jobs should always be analyzed before synchronization. |
| 10. | Start to **Synchronize** the jobs. If not analyzed yet, DirSync Pro will initiate **Analyze** first. |
| 11. | **Pause** analyzing/synchronizing. If a file is being copied, the program pauses after the copy process is carried out. |
| 12. | **Stop** analyzing/synchronizing. If a file is being copied, the program stops after the copy process is carried out. |
| 13. | **Shut down** the system after the synchronization is carried out. If you use this command, DirSync Pro will opens a count-down dialog for 30 seconds after which the system will shut down. |
| 15. | Stop the Synchronization Engine. |
| 16. | **Swap** the paths of **source and destination directories** in all jobs. |
| 17. | Open the **Generate command line** window which lets you create a batch command or batch file to run DirSync Pro in a batch. |
18. Open the **Options** window.
19. Display **Help contents** for DirSync Pro.
20. Start the default internet browser and goes to the Donation page to **Make a Donation**.
21. **Check for** program **updates** if available.
22. Display information **About** DirSync Pro.
23. **New jobset short-cut.**
26. Save jobset As short-cut.
27. **Analyze short-cut.**
28. **Synchronize short-cut.**
30. Stop Analyze/Synchronize short-cut.
31. Start the Schedule Engine short-cut.
32. Shut down the system after the synchronization is carried out.
33. Stop the Schedule Engine short-cut.
34. **About short-cut.**
35. **Help contents short-cut.**
36. **Make a Donation short-cut.**
3.2 Main Window

3.2.1 Job Tree

1. The Jobs tab: shows the configured jobs in a visual tree.
2. The Job tree: shows the details of the configured jobs.
3. Enable/Disable check box: to enable or disable a job for synchronization. Only the enabled directories get synchronized.
4. Add a new job to the tree.
5. Edit the selected job. This opens the Job Edit dialog for the selected job.
6. Move the selected job Up. The jobs are synchronized from top to down. Upper jobs get synchronized first.
7. Move the selected job Down. The jobs are synchronized from top to down. Upper jobs get synchronized first.
8. **Copy** the selected job.
9. **Remove** the selected job.
10. Enable **All** jobs.
11. Disable all jobs (None enabled).
12. **Expand** the job tree one level. This opens up the tree for one level. Clicking it once more, will expand the tree another level.
13. **Collapse** the job tree.
14. The **Total** progress of the overall synchronization. During the synchronization this bar shows also the elapsed and remaining time.
15. The progress of the synchronization of the **Current** item. During the analyze process, this bar shows the steps being carried out. During the synchronization this bar shows also the name of the file/directory being synchronized.
3.2.2 Synchronization queue

3.2.2.1 Synchronization queue: Summary tab

1. The **Sync Queue** tab: shows the synchronization queue. You'll see here all the files which are going to be synchronized.

2. The **Summary** tab: shows some statistics about the synchronization: number/size of Analyzed files/directories, number/size of files/directories to be synchronized, number/size of New files/directories, number/size of Modified files, number/size of Larger files, number/size of files which are Larger and modified and number/size of files/directories to be deleted.

3. The **statistics** of the current synchronization.

4. The number of **Analyzed** files/directories.

5. The number of files/directories To be **Synchronized**.

6. The number of files/directories To be copied **Always**.

7. The number of **New** files/directories.

8. The number of **Modified** files/directories.

9. The number of **Larger** files.
10. The number of **Larger AND modified** files.

11. The number of files/directories To be **Deleted**.

12. The number of files/directories which are involved in a synchronization conflict.

13. The **Synchronization Queue** list which shows the file names, modification dates and sizes of the files in Directory A and Directory B.

By right clicking a record in the synchronization queue, you get a context-aware menu with which you may manipulate the synchronization queue.

### 3.2.2.2 Synchronization queue: View tab

1. The **View** tab: allows filtering the view of the synchronization. This filter does not affect the synchronization queue. It only affects files/directories currently being shown.

2. Show **New** files/dirs.

3. Show **Modified** files.

4. Show **Larger** files.

5. Show **Larger & Modified** files.
6. Show Files to be deleted.
7. Show Dirs to be deleted.
8. Show Conflict items
9. Reset the view filters.
10. Apply (OK) the filters.

3.2.2.3 Synchronization queue: Filter tab

1. The Filter tab: allows filtering the synchronization queue. This helps you to make a selection of files to be synchronized. This filter does affect the synchronization queue. Only the files that remain in the queue are synchronized during the synchronization process.

2. Show New files/dirs.
3. Show Modified files.
4. Show Larger files.
5. Show Larger & Modified files.
6. Show Files to be deleted.
7. Show Dirs to be deleted.
8. Reset the view filters.
9. Show **Conflict** items
10. Apply (OK) the filters.

### 3.2.2.4 Right mouse click context menu

1. **Remove this** entry from the synchronization queue (not from the file system). This means that the corresponding file pair will not be synchronized.

2. **Remove all of this mode from** the synchronization queue, which means all the entry of which the synchronization mode is the same as the selected entry, will be removed from the synchronization queue (not from the file system) and so will not be synchronized.

3. **Remove all selected from** the synchronization queue, which means all selected (highlighted) entries will be removed from the synchronization queue (not from the file system) and so will not be synchronized. In the synchronization queue you may select multiple entries using the CTRL and/or SHIFT key in combination with left mouse click.

Additionally, depending on which column you right click, some other options will appear.

If you right mouse click on the name of a folder or a file, you may:

4. **Open** the file/directory in the system file explorer. If the file is associated with an application, the file is then opened in the regarding application.

5. **Open the parent folder** of a file in the system file explorer.

If you right click on the name/date/size of a file/directory, you’ll get a submenu:

14. **Add Exclude Filter** with which you may quickly add a context-aware filter. The filter dialog will then open automatically in which you may fine-tune the filter.

This context-aware filter holds various options based on the data of the selected file/directory. If you right click the name of a file/directory, you may:

7. Add a **Pattern** filter based on the name of the file/directory. After the filter dialog has
appeared, you may fine-tune the pattern manually.

8. Add a **Pattern** based on the file **Extension**. Again, you may fine-tune the filter in the filter dialog which opens automatically.

If you right click on the modification date of a file, the context-aware **Add Exclude Filter** lets you:

9. Add a date filter for files having earlier \(<\) modification date than the selected file size.

10. Add a date filter for files having exactly same \(=\) modification date as the selected file size.

11. Add a date filter for files having later \(>\) modification date than the selected file size.

If you right click on the file size of a file, the context-aware **Add Exclude Filter** lets you:

12. Add a file size filter for files having smaller \(<\) size than the selected file size.

13. Add a file size filter for files having exactly same \(=\) size as the selected file size.

14. Add a file size filter for files having larger \(>\) size than the selected file size.

If you right click on the synchronization mode, you'll get two submenu's:

15. **Change to**: which lets you change the mode of the selected synchronization item to another mode.

16. **Change all of this mode to**: which lets you change the mode of all the synchronization items with the same mode to another mode.

17. **Change all selected to**: which lets you change the mode of all the selected items to another mode.

Depending on the context, you may change the mode to:

18. Forced Copy File/Dir A

19. Forced Copy File/Dir B

20. File/Dir B is Redundant

21. File/Dir A is Redundant
3.2.3 **Schedule queue**

1. The **Schedule** tab: shows the scheduled synchronization tasks.

2. **Schedule Engine Status** line shows whether the synchronization engine is **Running** or **Not**.

3. The schedule table shows all the scheduled tasks. For each task the following information is shown:
   1. Type of the scheduled task (Once, Minutely, Hourly, Daily, Weekly and Monthly).
   2. The job the scheduled task belong to.
   3. The next following event (date/time) when the scheduled is being run.
   4. Details of the scheduled task.
3.2.4 Messages

1. The **Messages** tab: shows the messages being created during the analysis and synchronization process.
2. Allows filtering the **Info** messages.
3. Allows filtering the **Warning** messages.
4. Allows filtering the **Error** messages.
5. Allows filtering the **File** operations.
6. **Reset** the view filters.
7. **Apply (OK)** the filters.
8. **Clean** the Messages list.
### 3.3 Job options

#### 3.3.1 Basic options

1. The **Basics** tab: shows basic configuration of the job.

2. The **Label** of this job. The label is the name of the job. It is also used when to create the default log filename for this job.

3. The path to **Dir A** for this job. Here you specify the directory with the original files, also known as the source directory. You can specify here the following (case sensitive) wildcards:
   - `<username>` for the name of the current user, and
   - `<userhome>` for the home directory of the current user.
   You may drag a directory into this field which causes its absolute path to be copied into this field.

4. **Browse** for Dir A directory. **Important Note:** The Java Run-time Environment (JRE) which ships in recent Mac OSX's (like Lion) limits unfortunately the users access to other files-folders other than his/her personal files/folders. This limitation affects all Java applications (including DirSync Pro) which means no Java application can go beyond your personal files. We have no idea why Apple enforces this limitation to JRE for Mac users. The only way to eliminate this limitation is to install and use the original JRE from Sun/Oracle.

5. The path to **Dir B** for this job. Here you specify the directory which will be synchronized according to Dir A. This directory is also known as the destination directory. You can specify here the following (case sensitive) wildcards:
   - `<date>` for the current date, and
   - `<DD>` for the current day,
<MM> for the current month,
<YYYY> for the current year.
<time> for the current time, and
<hh> for the current hour,
<mm> for the current minute,
:ss> for the current second.
<username> for the name of the current user, and
<userhome> for the home directory of the current user.
You may drag a directory into this field which causes its absolute path to be
copied into this field.

6. **Browse** for Dir B directory.
7. **Swap** Dir A and Dir B.
8. **Includes subfolders** in this synchronization. Here you can decide whether you
want to synchronize the content of the source directory including subfolders or
not.
9. **Synchronization Mode** pull down. This pull down allows you to select pre-defined
synchronization configurations or to define your own custom configuration. The
options are:

   - **Mirror A -> B (incremental)**: This is a mono-directional (one way)
     preconfigured synchronization which copies all the new and modified
     files/directories from DirA to DirB. A file/directory in DirB which does not
     correspond to a file/directory in DirA is marked as redundant and will be
     deleted. DirB is exactly the same as DirA after the synchronization.

   - **Mirror B -> A (incremental)**: Same as 'Mirror A -> B (incremental)' with DirA
     and DirB swapped.

   - **Synchronize A <-> B (incremental)**: This is a bi-directional (two way)
     preconfigured synchronization which copies all the new and modified
     files/directories from DirA to DirB and from DirB to DirA. All redundant files in
     DirA/DirB (according to each other) will be deleted after the synchronization.
     DirA and DirB will be exactly the same after the synchronization. If you select
     this mode, you may also define the conflict resolution mode in the conflict
     resolution tab.

   - **Synchronize A <-> B (custom)**: Same as ‘Synchronize A <-> B
     (incremental)’ except some tabs get enabled in which you may set up your
     own options to define the synchronization behavior as you may wish.

   - **Backup A -> B (full)**: This is a full copy preconfigured synchronization which
     will copy all files/directories one-by-one from DirA to DirB. This mode is
     useful when you want to make a complete back up of DirA.

   - **Restore B -> A (full)**: This is a full copy preconfigured synchronization which
     will copy all files/directories one-by-one from DirB to DirA. This mode is
     useful when you want to restore a backup to DirA.

   - **Contribute A -> B (incremental)**: This is a mono-directional (one way)
     preconfigured synchronization which copies all the new files/directories from
     DirA to DirB. No file is deleted from DirB in this mode.

   - **Contribute B -> A (incremental)**: Same as 'Contribute A -> B (incremental)'.
     with DirA and DirB swapped.

   - **Synchronize A -> B (custom)**: This is a mono-directional (one way) custom
     synchronization from DirA to DirB. If you select this mode, some tabs get
     enabled in which you may set up your own options to define the
     synchronization behavior as you may wish.
• **Synchronize A -> B (custom):** Same as 'Synchronize A -> B (custom)' with DirA and DirB swapped.

• Context **Information** about this tab.

10. **OK** button to save all the settings to the job.

11. **Cancel** button to ignore all changes.

12. Context **Information** about this tab.

**Important note:** Some tabs get only available only in a **custom** synchronization mode.
3.3.2 Compare options

1. The **Compare** tab in which compare options are set.

2. **Compare file sizes and modification dates.** With this option, the file gets copied:
   1. when the file in Dir A is modified later than the file in Dir B (in case of New/Modified copy options), or:
   2. when the file in Dir A is larger than the file in Dir B (in case of Larger copy option).

3. **Compare file sizes, modification dates and meta data (attributes, permissions, ownerships):** With this option, the conditions from the previous option apply, plus that the file meta data is taken into account. The file will get copied if the modification data is changed (New/Modified copy option), file size is larger (Larger copy option) or attributes/POSIX permissions/POSIX ownerships are changed.

4. **Compare file contents:** with this option, the file contents will be compared byte by byte if the file sizes are the same. If file sizes differ, a sync conflict will occur. Please note that comparing file contents is a very time consuming task.

5. Context **Information** about this tab.
3.3.3 Copy options

1. The Copy tab in which copy options are set.

2. Copies All files and directories. If a file already exists in the destination directory it will always be overwritten with that one from the source directory. If you specify this option, all other copy options will be ignored.

3. Copies only New (not existing in destination directory) files and directories. Files that exist in the source directory but not in the destination directory will be copied to the destination directory.

4. Copies only Larger files and directories. If there already is a file with the same name in the destination directory, it will only be overwritten with the file from the source directory if its size is smaller than the size of the original file in the source directory.

5. Copies only Modified files and directories. If there already is a file with the same name in the destination directory, it will only be overwritten with the file from the source directory if its modified-date is older than the modified-date of the original file in the source directory.

6. Copies only Larger AND Modified files and directories. If there already is a file with the same name in the destination directory, it will only be overwritten with the file from the source directory if its size is smaller and its modified-date is older than the size and date of the original file in the source directory. If you specify the option 'Copy larger' or 'Copy modified', this option will be ignored (you already copied this files).

7. Context Information about this tab.
3.3.4 Conflict Resolution options

3.3.4.1 Mono-directional sync conflict resolution

1. The **Conflict Resolution** tab shows options when conflicts happen while using a mono-directional or bi-directional synchronization. You may set these options only if the Sync Mode is set to bi-directional or a custom mode.

2. **Mono-directional** conflict resolution tab.

   1. Mono-directional sync conflict resolution through **Overwriting the file in destination with the file from the source**: when synchronizing from mono-directional in a custom mode, if the file in destination is modified later (file is newer), the file from the source is copied over the file in destination; the file in destination will be overwritten.

   2. No Mono-directional sync conflict resolution **Do nothing. Just warn me**: when synchronizing from mono-directional in a custom mode, if the file in destination is modified later (file is newer), nothing will be copied. Instead the user gets a warning and could fix the conflict manually.

   3. No Mono-directional sync conflict resolution **Do nothing. Just skip silently**: when synchronizing from mono-directional in a custom mode, if the file in destination is modified later (file is newer), the file will be skipped silently.
3.3.4.2 Bi-directional sync conflict resolution

1. The **Conflict Resolution** tab: shows options when conflicts happen while using a mono-directional or bi-directional synchronization. You may set these options only if the Sync Mode is set to bi-directional or a custom mode.

2. **Bi-directional** conflict resolution tab.

3. Bi-directional sync conflict resolution through *Copying the latest modified file to both directories*: when synchronizing bidirectionally, if two files are modified in both directories individually, the latest modified file will be copied to both directories.

4. Bi-directional sync conflict resolution through *copying the largest file to both directories*: when synchronizing bidirectionally, if two files are modified in both directories individually, the largest file will be copied to both directories.

5. Bi-directional sync conflict resolution through *renaming copying both files to both directories*: when synchronizing bidirectionally, if two files are modified in both directories individually, they are postfixed (renamed with added extensions .DirA and .DirB) and they both will be copied to both directories.

6. No Bidirectional sync conflict resolution **Do nothing. Just warn me**: when synchronizing bidirectionally, if two files are modified in both directories individually, none of the files are copied. Instead the user gets a warning and could fix the conflict manually.

7. No Bi-directional sync conflict resolution **Do nothing. Just skip silently**: when synchronizing bidirectionally, if two files are modified in both directories individually, the files will be skipped silently.

8. Context **Information** about this tab.
3.3.5 Filters options

1. The Filters tab to define which files/directories should be included/excluded. You may redefine these options if the Sync Mode is set to custom.

2. Filters Tree gives an overview of all filters for this job in a tree structure.

3. Add a New filter.

4. Edit an existing filter. This button is enabled only if a filter in the filter tree is selected.

5. Remove an existing filter. This button is enabled only if a filter in the filter tree is selected.

6. Expand the filter tree one level. This opens up the tree for one level. Clicking it once more, will expand the tree another level.

7. Collapse the filter tree.

8. Context Information about this tab.
3.3.5.1 Adding/Editing a filter: Basics tab

1. The **Basics** tab to define the type of the filter and whether to include/exclude items.

2. Select here whether to **Include** or **Exclude** the matched files or directories.

3. **Include** the matched files or directories.

4. **Exclude** the matched files or directories.

5. Select here the **Filter type**. One of the tabs By Pattern and By Size will get enabled according to the selected filter type.

6. Filter based on **File/dir pattern**. This filter affects files and directories of which the name matches a text pattern.

7. Filter based on **File Size**. This filter affects files of which the size satisfy some conditions.

8. Filter based on **File Date**. This filter affects files of which the modification date satisfy some conditions.
9. Filter based on Path. This filter affects files/directories of which the absolute path is exactly the same as defined.

10. Filter based on File attributes. This filter affects files having one or more specific DOS attributes and may be defined only under MS Windows/DOS.

11. Filter based on File ownership. This filter affect files/directories having a specified owner or group and may be defined only under Posix systems (Linux, Unix, …).

12. Filter based on File Permissions. This filter affect files/directories having a specified file permission and may be defined only under Posix systems (Linux, Unix, …).

13. Context Information about this tab.

14. OK button to save all the filters.

15. Cancel button to ignore all changes.
3.3.5.2 Adding/Editing a filter: By Pattern tab

1. The **By Pattern** tab to define a pattern to match the name of the files or directories.

2. Define here the **Pattern** for the file/directory name. Only files/directories matching a specified pattern should be included or excluded. For example if you specify '*.txt' only files/directories that end with '.txt' will be processed; or if you specify '*_new', only files/directories that end with '_new' will be processed. You can use wildcards (i.e. '?', and '*'). '?' means zero, or one character, '*' means zero, one, or more characters. If you wish to enter many patterns, you may enter them here. You may enter multiple patterns by separating them using semi-column (';') character, like '*.gif;*.jpg;*.png'. When you click on OK, multiple patterns will be parsed and split into individual pattern filters.

3. Pattern is a **File** pattern.

4. Pattern is a **Directory** pattern.

5. When this option is selected, the pattern is interpreted as a **regular expression**.
6. Context **Information** about this tab.

### 3.3.5.3 Adding/Editing a filter: By File Size tab

1. The **By File Size** tab to define filters based on file sizes.
2. Match files **Smaller** than.
3. Match files **Exactly** with the size.
4. Match files **Larger** than.
5. The **File size** in bytes.
6. Context **Information** about this tab.
3.3.5.4 Adding/Editing a filter: By File Date tab

1. The **By File Date** tab to define filters based on file dates.
2. Match files **Earlier than**.
3. Match files **Exactly on** a date.
4. Match files **Later than**.
5. Set this filter based on a **Specific Time**. In this case the specified time will be used to compare to the modification time.
6. The specific **Time** formatted as dd-MM-yyyy HH:mm.
7. Set this filter based on number of some **Time unit**. In this case the modification time is relatively compared to ‘now’, according to the number of specified time unit (like: ‘10 days ago’).
8. **Number** of time units to be specified.
9. The **Time unit** to be specified; available options are: Hours, Days, Weeks, Months.

Information

You can define here a filter to include/exclude files/directories based on their modification date. A modification date is checked to be earlier than, later than or exactly on a specific time or a given time unit (like 10 days ago).
10. Context **Information** about this tab.

### 3.3.5.5 Adding/Editing a filter: By Path tab

1. The **By Path** tab to define filters based on the file/directory path.
2. The **Path** to the file/directory.
3. **Browse** button to select a file/directory.
4. Context **Information** about this tab.

> If you would like to include or exclude a specific file or a directory, you may select here the absolute path to it. Please pay attention when combining an 'absolute path inclusion' with 'pattern inclusion'. The combination could be pretty complicated to understand the behavior.
3.3.5.6 Adding/Editing a filter: By Attribute tab

1. The **By File Attribute** tab to define filters based on DOS attributes of the file.
2. Match files with the **Read only**.
3. Match files with the **Hidden** attribute.
4. Match files with the **System** attribute.
5. Match files with the **Archive** attribute.
6. Context **Information** about this tab.

This filter could only be defined on MS Windows/DOS systems.
3.3.5.7 Adding/Editing a filter: By Ownership tab

1. The **By File Ownership** tab to define filters based on Posix ownerships of the file/directory.

2. Match files/directories with the specified **Owner**.

3. Match files/directories with the specified **Group**.

4. Context **Information** about this tab.

This filter could only be defined on Posix systems (Linux/Unix, ...).
3.3.5.8 Adding/Editing a filter: By Permission tab

1. The **By File Ownership** tab to define filters based on Posix permissions of the file/directory.

2. Match files/directories with the specified bit-wise permissions. Once you edit these check-boxes, the Numeric value will be calculated and updated automatically in the corresponding field.

3. Match files/directories with the specified Numeric permission. Once you edit this value, the bit-wise permissions will be calculated and updated automatically in the corresponding check-boxes.

4. Context **Information** about this tab.

This filter could only be defined on Posix systems (Linux/Unix, ...).
3.3.6 Deletion options

1. The **Deletion** tab to define the deletion behavior after the synchronization. You may redefine these options if the Sync Mode is set to custom.

2. **Delete files** not existing in the source directory from the destination directory. Files that have been deleted in the source directory, but still exist in the destination directory will be deleted in the destination directory.

3. **Delete directories** not existing in the source directory from the destination directory. Directories that have been deleted in the source directory, but still exist in the destination directory will be deleted in the destination directory.

4. **Delete Excluded Files** from **Dir A**. When this option is selected all files which match the Excluded Files pattern will be cleaned up (deleted) from Dir A.

5. **Delete Excluded Directories** from **Dir A**. When this option is selected all files which match the Excluded Directories pattern will be cleaned up (deleted) from Dir A.

6. **Delete Excluded Files** from **Dir B**. When this option is selected all files which match the Excluded Files pattern will be cleaned up (deleted) from Dir A.

7. **Delete Excluded Directories** from **Dir B**. When this option is selected all files which match the Excluded Directories pattern will be cleaned up (deleted) from Dir A.

8. Context **Information** about this tab.
3.3.7 Backup options

1. The **Backup** tab to define the backup behavior during the synchronization. You may redefine these options if the Sync Mode is set to custom.

2. **Keep n backups**: Before a file in the destination directory will be overwritten or deleted the file is copied to a special subdirectory of the destination directory as a backup.

3. **Keep the backup dir within the destination directory**. If this option is not selected, an alternative backup folder could be specified.

4. **Alternative Backup directory** in which the backup files will be created.

5. **Browse** for the alternative Backup directory.

6. **Context Information** about this tab.
3.3.8 Logging options

1. The Log tab to define the logging behavior after the synchronization.
2. Enable or disable separate logging for this job.
3. The Logfile. Normally the name of the job (label) is used to create the initial filename for the log. You may also specify a custom filename. New log entries are appended to the existing logfiles and hence they will not be overwritten. You can specify here the following (case sensitive) wildcards:
   - <date> for the current date, and
   - <DD> for the current day,
   - <MM> for the current month,
   - <YYYY> for the current year.
   - <time> for the current time, and
   - <hh> for the current hour,
   - <mm> for the current minute,
   - <ss> for the current second.
   - <username> for the name of the current user, and
   - <userhome> for the home directory of the current user.
4. Browse for the logfile or directory.
5. Context Information about this tab.
3.3.9 Schedule options

1. The Schedules tab to define schedules for this job. Schedules cause this job to synchronize automatically on a certain time or recurrently according to a pattern.

2. Schedule Tree gives an overview of all schedules for this job in a tree structure. If a schedule task of type Once has already run or if a recurrent schedule task does not have a valid next event date due to its constraints, the schedule gets suffixed with '(Expired)' in the schedule tree.

3. Add a New schedule.

4. Edit an existing schedule. This button is enabled only if a schedule in the schedule tree is selected.

5. Remove an existing schedule. This button is enabled only if a schedule in the schedule tree is selected.

6. Expand the schedule tree one level. This opens up the tree for one level. Clicking it once more, will expand the tree another level.

7. Collapse the schedule tree.

8. Context Information about this tab.

Please note: After defining a Schedule job, you need to start the Schedule Engine in the Main Window and Dirsync Pro program should keep running (but may be minimized).
3.3.9.1 Adding/Editing a schedule: Basics tab

1. The **Basics** tab to define the type of the schedule and some general settings.

2. Select here the **Schedule type**. There are 6 types are schedules available.

3. **Once**: This schedule runs only once on a certain date/time.

4. **Minutely**: This schedule runs recurrently every X minutes.

5. **Hourly**: This schedule runs recurrently every X hours.

6. **Daily**: This schedule runs recurrently on a certain time daily.

7. **Weekly**: This schedule runs recurrently on a certain time and in specific months every X weeks.

8. **Monthly**: This schedule runs recurrently every month on day number X, on a certain time and in specific months. After selecting a schedule type, the corresponding tab will get enabled in which you may set up additional options.

9. Define here if the task should run only during a time frame (From ... To).

10. **Enable Time frame** From constraint.

11. **Time frame** From date value. If defined, the task will run only if its next event date is after this date.
12. **Enable Time frame To** constraint.
13. **Time frame To date value.** If defined, the task will run only if its next event date is after this date.
14. Context **Information** about this tab.
15. **OK** button to save all the filters.
16. **Cancel** button to ignore all changes.

### 3.3.9.2 Adding/Editing a schedule: Schedule Once

![Schedule Once Tab](image)

1. The Schedule **Once** tab in which you may define a task which runs once on a certain time. If a Once schedule is not run, e.g. because other tasks are running all the time, it will be queued for execution and will run later again. A Once schedule which is older than 24 hours, will not run anymore.
2. The **Time** on which this schedule will run.
3. Context **Information** about this tab.
3.3.9.3 Adding/Editing a schedule: Schedule Minutely

1. The Schedule **Minutely** tab in which you may define a task which runs recurrently every X minutes. The first occurrence will get scheduled for 'now'.

2. The **interval** in minutes.

3. Context Information about this tab.
3.3.9.4 Adding/Editing a schedule: Schedule Hourly

1. The Schedule **Hourly** tab in which you may define a task which runs recurrently every X hours. The first occurrence will get scheduled for the next complete hours (01:00, 02:00, 03:00, ...).

2. The **interval** in hours.

3. Context **Information** about this tab.
3.3.9.5 Adding/Editing a schedule: Schedule Daily

1. The Schedule Daily tab in which you may define a task which runs recurrently every X days on a certain time.
2. The interval in days.
3. The time of the day on which this task should run.
4. Context Information about this tab.
3.3.9.6 Adding/Editing a schedule: Schedule Weekly

1. The Schedule **Weekly** tab in which you may define a task which runs recurrently every X weeks on a certain time and on specific weekdays.

2. The **interval** in weeks.

3. The **time** of the day on which this task should run.

4. Checkboxes to select on which **weekdays** this schedule task should run.

5. Context **Information** about this tab.
3.3.9.7 Adding/Editing a schedule: Schedule Monthly

1. The Schedule **Monthly** tab in which you may define a task which runs recurrently every month on day number X, on a certain time and in specific months.
2. The **Xth** day of the month.
3. The **time** of the day on which this task should run.
4. Checkboxes to select on which **months** this schedule task should run.
5. Context **information** about this tab.
3.3.10 Advanced options

1. The Advanced tab to define advanced options.

2. **Timestamp granularity** is the tolerance in seconds when comparing the modification time of files/folders. Normally the granularity should be zero but in some cases the file system fails to set the exact modification time, e.g. when using a network drive or copying files across platforms. Two files with modification dates difference less than the granularity will be treated as 'not modified'.

3. **Ignore daylight saving granularity** could be useful when synchronizing between FAT and other file systems. This option makes that two files with modification time difference exactly 1 hour are treated as equal.

4. **Preserve timestamps of the directories** makes that the timestamps of the directories in destination get identical to that of the directories in the source. This option maybe useful for MS Windows/DOS users.

5. **Write timestamps back to source files** causes to write the time stamps of the copied files back to the source files. Caution: use this if you really need to.

6. **Real-time synchronization** option could be used to watch a directory automatically and continuously. If this option is set, DirSync Pro starts synchronizing after the preset number of seconds is passed since the last change is detected.

7. This is the **number** of seconds to wait before the next round of real-time synchronization is automatically started.

8. **Synchronization on start** causes an initial synchronization prior to monitoring the real-time changes.

9. **Verify the synchronized files** causes that after a file has been copied checksums of the source and destination file are calculated and compared. If the checksums don't match an "Verify error" will be reported. This option could be useful if the destination media are not completely trusted.

10. **Skip symbolic links** causes that symbolic **links are ignored** while copying. Only
applies if the source file system uses symbolic links (UNIX, Linux, Mac OSX).

11. **Copy symbolic links** causes that symbolic links are verbatim copied. This will create symbolic links in the destination folder (UNIX, Linux, Mac OSX).

12. **Preserve DOS attributes** causes that the DOS file attributes of the files in destination get identical to that of the files in the source. This option maybe useful for MS Windows/DOS users and could only be set under these systems.

13. **Preserve file permissions** causes that the Posix permissions of the files/directories in destination get identical to that of the files/directories in the source. This option maybe useful for Posix users and could only be set under these systems.

14. **Preserve file ownership** causes that the Posix ownerships of the files/directories in destination get identical to that of the files/directories in the source. This option maybe useful for Posix users and could only be set under these systems.

15. **Attempt to override read-only attribute in destination when copying/deleting** causes the copy/deletion process to ignore the read-only (MS-DOS) flag in the destination.

16. Context Information about this tab.

**Understanding timestamp related problems**

Some file systems do not store timestamps accurately (e.g. FAT) and it is possible that problems with the option "Modified" arise (e.g. FAT always forces the time stamp down to even seconds; if you copy a file with a source timestamp of "12:05:01" to FAT it will be stored with a destination timestamp of "12:05:00". The next time you synchronize this file with the "Copy modified" option it will be copied again because the source timestamp is newer than the destination timestamp).
3.3.11  Job Actions

1. The actions tab to perform some actions on the job settings.

2. Copy all the job options (except the paths) to all jobs in the job tree.

3. Copy all the job options (except the paths) to enabled jobs in the job tree.

4. Reset all the job settings (except the paths) to initial default settings. This loads the application defaults to your job.

5. Context information about this tab.
3.4 Generate command line tool

Using this tool you may let DirSync Pro create the command line for you. The command line could be used to start DirSync Pro directly from the command line. You could also write the command line to a batch file to start a specific synchronization directly.

This tool is smart enough to check the type of the operating system (MS Windows vs. Linux-like systems and uses the corresponding option delimiter (/ or -), file separator character (\ or /) and file and path conventions.

1. This option adds a /sync (Or -sync for Linux-like systems) options to the command line causes DirSync Pro to start synchronizing right away.

2. This option adds a /analyze (Or -analyze for UNIX-like systems) options to the command line which causes DirSync Pro to start analyzing right away.

3. This option adds /schedule (Or -schedule for UNIX-like systems) options to the command line which causes DirSync Pro to start the schedule engine as soon as the GUI is started.

4. This option adds a /nogui (Or -nogui for UNIX-like systems) options to the command line which causes DirSync Pro to start no graphical user interface.

5. This option adds a /quit (Or -quit for UNIX-like systems) options to the command line which causes DirSync Pro to quit right after the synchronization.

6. This option adds a /iconify (Or -iconify for UNIX-like systems) options to the command line which causes DirSync Pro to minimize to the system tray upon start-up.

7. The created command line.

8. Close the window without further actions.

9. Copy the created command line to the system clipboard. You may paste this clipboard elsewhere.
10. **Save** the created command line to a **batch file**. After clicking this button, you will be asked to provide a filename. The extension `.cmd` and `.sh` are used for the batchfile on MS Windows systems and Linux-like systems respectively.

### 3.5 Application Options window

#### 3.5.1 General options

1. The **General** tab to define general application options.

2. Whether the jobset files are saved in the **program folder**. In some cases it is useful to define another jobset path for example if you do not have write permissions in the program folder.

3. The **path** to the directory in which the jobset files reside. You can define a path in which you usually keep your saved jobset files.

4. **Browse** for the jobset files path.

5. If the **Load last loaded jobset** is set, DirSync Pro will load the jobset that was loaded in the last session automatically upon start up.

6. If the **Start the Schedule Engine upon start up** is set, DirSync Pro runs the Schedule Engine as soon as the program is started.

7. **Check for DirSync Pro program updates** every time at start-up. If an update is available following window will show up and lets you go to the download page to download the latest version.
8. **Check for DirSync Pro program updates Now.** If an update is available following window will show up and lets you go to the download page to download the latest version.

9. **OK** with the changes and exit options window.

10. **Cancel** the changes and exit options window.

### 3.5.1.1 Update window

1. **Information** about the available update (version, links, …)

2. **Go to download page** starts the default internet browser and opens the DirSync Pro update website.

3. **Not Now** will close this window without further actions.
3.5.2 View options

1. The View tab to define application view options.

2. Use **System “Native Windows” look & feel**: If you are using MS Windows or MacOS, you can select to use your own native windows look & feel.

3. Use **Java “Metal” look & feel**.

4. If the **Minimize to the system tray** option is set, DirSync Pro will minimize to the system tray when you minimize the application window. DirSync Pro is then still running, but the application window is not visible anymore.

5. The option **Use single click instead of double click** defines whether the main application window should be restored by a single click or a double one on the DirSync Pro system tray icon.
3.5.3 Synchronization options

1. The **Sync** tab to define application synchronization options.

2. If **Keep the sync queue after synchronization** is set, DirSync Pro will not clear the synchronization queue when the synchronization is carried out. This option could be helpful if you get warnings on some items during the synchronization and you want to resynchronize those items. If you synchronize the remaining queue again, only the items which have not been synchronized will be retried.

3. You may change here the **Shut-down command** which is being used to turn off the system when all the synchronization jobs are carried out.

4. **Default** button sets the command back to the default value. The default shut-down command is depending on which operating system you use (MS Windows/DOS or Posix).
3.5.4 Log options

1. The Log tab to define logging settings.

2. Enable/disable global logging. If enabled, DirSync Pro writes all the individual messages of all jobsets to a global log file (`DirSyncPro.log`).

3. Enable/disable jobset logging. If enabled, DirSync Pro writes all the individual messages of all jobs belonging to a jobset to the jobset log file (`[JOBSET].log` or custom name if defined in the job settings).

4. Whether the log files (global log or individual logs) are saved in the program folder. In some cases it is useful to define another log path for example if you do not have write permissions in the program folder.

5. The path to the directory in which the log files should be saved. Please see the chapter 'Advanced features' for explanation on default values for this option.


7. Use Minimal log level: only events, warnings and errors are logged.

8. Use Moderate log level: events, warnings, errors and file names are logged.

9. Use Excessive log level: events, warnings, errors, file names and configuration data are logged.

3.6 Command Line

You can use the GUI to generate the command line or even save it to a batch file. The syntax of the command line is:

-**help** Display help on homepage, contact, and license.
-**usage** Displays this screen.
-**sync** Starts a synchronization if a configuration file is specified.
-**analyze** Starts a analysis rather than a synchronization if a configuration file is specified.
-**schedule** Starts the schedule engine as soon as the the GUI is started.
-**iconify** Minimizes the Gui to the tray (if available) on start-up.
-**quit** Quits the program after the analyze or the synchronization.
-**nogui** Start DirSync Pro in console mode and start synchronization (only useful if a configuration file is being specified).

Command line options start with a slash "/" on Windows and with a minus "-" on all other operating systems.

**Examples:**
Start in GUI mode:
dirsyncpro
Start synchronization in GUI mode and quit afterwards:
dirsyncpro -sync -quit <jobset file>

On Windows:
dirsyncpro /sync /quit <jobset file>

Start synchronization in command line mode:
dirsyncpro -nogui <jobset file>

On Windows:
dirsyncpro /nogui <jobset file>

### 3.7 Advanced features

#### 3.7.1 Default directory for program settings

DirSync Pro saves its settings (dirsyncpro.properties) in the program folder by default. If the program folder is not writable, DirSync Pro uses either the value of the dirsyncpro.home system property, if defined, or XXX/.DirSyncPro in which XXX stands for the user.home system property. You may define the dirsyncpro.home system property when running DirSync Pro. To do so you should use something like:

```
java -Xmx512M -Ddirsyncpro.home="D:\" -jar dirsyncpro.jar
```

Characters like '＼' must be escaped.

#### 3.7.2 Default directory for saving logs

DirSync Pro saves the logs (if enabled) by default in the folder where the program settings are saved (see **Default directory for program settings**). You can change this default directory by defining a new default directory through the options window in the GUI.
3.7.3 Default directory for saving configurations

When you want to open a configuration or when you are about to save one, the file choosing dialog starts in the directory where the program settings are saved (see Default directory for program settings). You can change this default directory by defining a new default directory through the options window in the GUI.

3.7.4 Log behavior

DirSync Pro lets you create a log file for the synchronization (configuration) and for each individual Directory Profile. The log file for the synchronization is by default enabled. You may disable this log file in the Default Settings tab, if you wish. The log file name is initially set to the Synchronization name (this is the file name of your configuration). You may change the log file name or path in the same tab.

If a Directory Profile is set to default settings, it'll log into the Synchronization log, if the log is enabled. If it is not set to default, it's log file is disabled initially. You may enable the log in the Directory Settings tab. The log file name is initially set to the Directory Profile name. You may change the log file name or path in the same tab.

3.7.5 Schedule a synchronization

DirSync Pro has a powerful synchronization engine with lots of scheduling features. But if, for whatever reason, these features aren't enough for your purpose, you may use existing scheduling tools in your operating system (like cron in Linux and Windows Task Scheduler in Microsoft Windows) to setup scheduled tasks to run a synchronization with DirSync Pro. This is how you can do it:

1. Use DirSync Pro user interface to setup your synchronization.
2. Save your configuration file.
3. Use the command line generator tool to create your command line with with /quit and /sync en eventually /nogui options. Save this command line to a batch file.
4. Use your system scheduler to run the created batch file as you like.

3.7.6 Auto start in MS Windows

You may want DirSync Pro to start automatically when you plug a USB drive under MS Windows. To do so, create a file called autorun.inf with the following content:

```
[AutoRun]
ACTION=Backup
Open=java -jar dirsncpro\dirsncpro.jar JobsetFile.dsc
```

And in case you want it to quit right away after the synchronization:

```
[AutoRun]
ACTION=Backup
Open=java -jar dirsncpro\dirsncpro.jar JobsetFile.dsc /sync /quit
```

In which the JobsetFile.dsc is your corresponding preconfigured and saved jobset file. Please note that you may need to adjust the command in front of Open= to suit the paths in your system. You should use the command line generator tool (under Tools menu) to create the right command for you.
3.7.7 Allocating more memory for DirSync Pro

If you run DirSync Pro through the command line, you may need to allocate more memory for example when synchronizing massive number of files. If you want to allocate more memory to DirSyncPro, use the following command to run DirSync Pro with 512MB (adjust to own will):

```java
java -Xmx512M -jar dirsyncpro.jar
```

You may choose a larger amount if you need to.

If you start DirSync Pro through the wrapper `DirSyncPro.exe` under MS Windows, the wrapper `DirSyncPro.exe` itself already uses 512MB memory.

4 Frequently Asked Questions (FAQ)

Please visit [www.dirsyncpro.org/faq.html](http://www.dirsyncpro.org/faq.html) for a recent list of FAQ.